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What’s new 

Manual 

The instructions for the bbe PDA are located in an extra manual. 

Please Note: 

Decimal points are according to local settings of Windows, i.e. internationally, the decimal point is “.” but in most 
of Europe it is “,“. Please pay attention to this. Most import/export difficulties are caused by the use of the “point” 
or “comma” and vice versa. The software screenshots in this manual contain “decimal commas”, i.e. the 
European system. 
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General Safety Precautions 

The bbe FluoroProbe is an instrument for the determination of the concentration of 
chlorophyll in water. It should only be used for this purpose. 

• only instructed staff should operate this instrument.

• consult appropriate safety manual in case of using hazardous compounds and
solutions. Wear gloves, coat and safety goggles.

• electrical connection of the instrument should only be carried out by trained staff.

• the instrument should only be opened by authorized staff.

• please refer to the safety instructions of any chemicals used with the FluoroProbe.

• changes to electrical connections and circuits may cause damage to the instrument
and lead to loss of warranty.

Cleaning the instrument: 

The instrument should be cleaned after use. The use of aggressive cleaning fluids or water at high pressure 
should be avoided. Neither should any mechanical cleaners or apparatus come into contact with the sensor 
head or LED display. Attention: in order to obtain exact measurement results, the measuring head should be 
free from grease. 
Before stowing the instruments should be cleaned of dirt under running water. If necessary, normal, 
commercially available washing up liquid can be used. Rub the instrument dry with a soft cloth and take care 
when drying the electrical contacts. 
The simplest way to store the instrument for any length of time is in its original case, in which the accessories 
can also be stored and kept dry. 

Supplement to the safety instructions 

Performing electrical connection may only be carried out by trained personnel. Maintenance, such as e.g. 
exchanging the rechargeable battery pack, may only be carried out by personnel trained and authorised by bbe 
Moldaenke. Replacement parts and repair materials must be issued/released by bbe Moldaenke for each case. 

Use of the FluoroProbe without Screen 

The FluoroProbe must not be used in sunlight without the Screen. 
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How to Quick-Start the Instrument 

 
This gives a very short overview of the measurement with the bbe FluoroProbe. For more details, please read 
the next chapters. 
 

• install the PC software 

• install the driver for the RS485 to USB converter from the installation CD (driver\FluporoProbe\ 
CDM20814_Setup) 

• connect the RS485 to USB converter cable to the PC. 

• connect the bbe FluoroProbe and the PC using the measuring cable/RS485 to USB converter cable; make 
sure that the connector has been greased sufficiently 

• start the PC software 

• choose the COM port for the connected instrument or let the bbe++ software search for it 

• calibrate the offsets and/or the fingerprint of yellow substances especially in case of low concentrations of 
chlorophyll (< 10 µg/l, total chlorophyll concentration) 

• set the air pressure by using this item in “Tools -> Device -> Air pressure”  

• start the measurement (“Start” button in the toolbar ) 

• after starting the measurement, it takes about 30s until the first results appear 

• submerse the FluoroProbe when the first value appears 

• at the end of the measurement, stop the measurement 
 



Construction of the bbe FluoroProbe 

bbe FluoroProbe manual page 10 

Construction of the bbe FluoroProbe 

Components - without the screen (1000m version is shown) 

Connector 
with cap 

Carrying cable 

Photomultiplier 
window 

LED window 

Transmission 
window 

Temperature 
sensor 

LED 

Screen 

The screen for the FluoroProbe is used when measuring small concentrations or in bright sunlight. To clean the 
FluoroProbe windows, the screen can be dismounted by removing the 8 screws.  

OPENING THE CASING 

Attention! Do not open the instrument - danger of leakage! 

Maintenance and repairs are to be carried out only by the manufacturer or its authorised agents. 
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Installation 

Cables 

There are two cables delivered with the bbe FluoroProbe: 

• The measuring cable (underwater cable):

This cable is used during measurement with the bbe FluoroProbe. Different lengths from 2 to 100m are
available. This cable is also used to operate the bbe FluoroProbe in the lab and to charge the battery. The
bbe FluoroProbe can also be operated using the power supply.

• Converter cable

The FluoroProbe uses the RS485 standard to transmit the data to a PC. This allows the transmission of data
via long cables. To connect the FluoroProbe to a PC a converter is required. The converter is integrated into
the converter cable. There are two types of converter available: An RS485 to USB type and an RS485 to
RS232 type.

Both converters are equipped with a wire strap to switch the FluoroProbe on as soon as the converter is
connected.



Installation 

bbe FluoroProbe manual   page 12 

• The RS485 to USB converter cable 

Before using this cable, the USB driver needs to be installed (on the bbe CD). 

 

 

 

• The RS485 to RS232 converter cable (optional) 

This converter cable can be used with a free RS232 port. 
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Connector  

 
Connector of the bbe FluoroProbe series 18 and up (view from the top). 
 
Please note: the use of the connector pins is different from previous series! 
 

 

1 

8 

7 

6 

5 

4 
3 

2 

 
 
1.  Positive power supply (24 V) 
2.  RS 485 B 
3.  RS 485 A 
4.  Ground 
5.  Input to switch the FluoroProbe ON by connecting to pin 6 
6.  Positive pin of the battery 
7.  USB - 
8.  USB + 
 
The converter cable connects Pins 5 and 6 to start the Probe. 
 

Connector Maintenance: 

The connectors have to be treated with grease regularly. Please use a Molykote 44 medium. This is available 
from bbe Moldaenke. 
 
The silicon grease is only to be applied to the non-metal parts but is needed to be able to disconnect the 
connectors more easily after use. The grease is to be applied where the plastic parts of the male and female 
connectors make contact. It may be applied thinly but more than normal will not damage the instrument. It is 
recommended to dry the connectors roughly beforehand with a cloth or something similar. 
 
In several tests, we have found that it does not influence operation when silicon grease is applied to the metal 
contacts by mistake. Nevertheless, care should be taken during application. 
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CONNECTING THE FLUOROPROBE 

Eye

Plug with 
fixing screw

Underwater 
cable

Connecting the underwater cable: 

• remove the protecting plug

• connect the underwater cable and fix the locking sleeve

• connect the carrying cable of the FluoroProbe with the eye of the underwater cable

The underwater cable is used to supply the FluoroProbe with power, to transfer the data and to suspend the 
FluoroProbe in the water, while submersed. 
The FluoroProbe starts as soon as the power supply or the converter cable has been connected. Both items 
connect PIN 5 and 6 of the FluoroProbe to switch it on. 

Power supply 

The bbe FluoroProbe is either powered by connecting the external power supply (see below) or by using the 
internal battery.  

The FluoroProbe is switched on by connecting Pins 5 and 6 of the connector by using the power supply, the 
converter cable or the auto-start-plug. 

This is done by connecting the measuring cable to the FluoroProbe and the converter cable to the measuring 
cable. Disconnect all cables when FluoroProbe is not in use.  

NOTE:  
Connected cables may switch the FluoroProbe on. This will consume power from the internal batteries 
of the FluoroProbe and thus the batteries may become discharged. 
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INDICATION OF OPERATION MODE AND CHARGE STATE  (SERIES 23 AND UP) 

 

    
 
The LED in the lid indicates the operation mode and the charge state. 
 
The charge state is indicated by the color of the LED 
 
Charge state Color 

Full  Green 

Medium Yellow-Orange 

Nearly empty Red 

 
The operation mode is indicated by the type of blinking of the LED 
 
Mode Blinking 

Off Off 

Standby Short light pulses 

Measuring Regular pulses 

Charging On 

Start-up procedure  

In series 23 and up, there is a LED in the lid indicating the startup procedure (please see above). 
 
The start-up procedure is indicated by the LEDs of the FluoroProbe. This can be used to control the start-up 
procedure. Please remove the black screen to have a better view to the LEDs. 
 
The FluoroProbe starts after connecting the autostart plug, the converter cable or the power supply. This 
procedure takes about 10 s. During these 10 s the orange LED lights up. Then, a different LED indicates the 
status of the internal rechargeable battery for 2 s. 
 
Green LED means: battery charged 
Red LED means: battery not charged 
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USING THE AUTOSTART PLUG 

The autostart plug is used to measure without a PC or handheld device. The autostart plug connects pins 5 and 
6 and initiates the measurement. The FluoroProbe needs to be configurated accordingly. Please see page 101. 
 

 

Downloading data from the FluoroProbe using a USB stick 

To download data files from the FluoroProbe, a USB adapter can be used. 
 

 
 
Connecting the USB plug with a USB stick to the FluoroProbe initiates the transfer of all hitherto untransferred 
data files to the USB stick. For FluoroProbes series 18 and 19, the transfer starts with the oldest data and must 
not be interrupted. In FluoroProbes series 20 and upwards, the transfer starts with the latest data and may be 
interrupted. Additionally, a file called “datacopy.log” is written to the USB stick. This file contains information 
about the copied files and the remaining files. 
 
Example of datacopy.log: 
 
Wed Jan 27 02:38:11 UTC 2010 
total number of FLP files found: 48 
number of FLP files copied so far: 10 
number of FLP files remaining: 38 
number of FLP files copied so far: 20 
number of FLP files remaining: 28 
number of FLP files copied so far: 30 



Installation 

bbe FluoroProbe manual   page 17 

number of FLP files remaining: 18 
number of FLP files copied so far: 40 
number of FLP files remaining: 8 
number of FLP files copied so far: 48 
number of FLP files remaining: 0 
 
execution summary: 
number of FLP files copied: 48 
number of FLP files remaining: 0  
 
Each single series of measurements is stored in one *.FLP file. The files are stored in monthly folders, with daily 
subfolders:  
 

 
(Note: ‘Wechseldatenträger’ may appear as ‘Removable drive’ in English operation systems) 
 
The files are named according to the date and time of the beginning of the measurement: 
 

 

Updating the firmware of the FluoroProbe using a USB stick 

To update the internal firmware of the FluoroProbe get the latest software from the bbe service or the bbe 
website. The firmware is a file called  
 
FPUpdate.bin 
 
Please note: the name is the same for all kinds of updates. 
 
Applying the update: 

• Copy this file to a USB stick  

• Connect it to the USB adaptor 

• The FluoroProbe loads the file FPupdate.bin. As soon as the update is finished, the file will be renamed 
to FPUpdate.bin.done. This shows, that the update has been successful. Depending on the update, 
there may be also log files on the USB stick. 

• Wait until the FluoroProbe reboot (LEDs of the FluoroProbe are blinking) 

• Disconnect the USB stick 

• Connect the USB stick to a PC to check for FPUpdate.bin.done. For further updates of other devices, 
the file can be re-renamed to FpUpdate.bin. 

• Send the log files to the bbe service, if requested. 

• To check the software version connect the FluoroProbe to a PC with bbe++ installed and go to 
Parameters -> online ->common parameters -> software version 

Power Supply  and Charging of the FluoroProbe 

 
The power supply is used to charge of the internal rechargeable battery as well as to operate the FluoroProbe in 
stationary or “lab” mode.. 
The power supply has a cable with two connectors: one to supply the FluoroProbe with power/charge the 
batteries and the other to connect the computer to the FluoroProbe during measurement with the power supply. 
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Do not use the power supply of a series 18 and up instrument for an earlier type! 

CHARGING OF THE FLUOROPROBE 

Connect the power supply via the measuring cable to the FluoroProbe. Connect the power supply to the mains.  
The FluoroProbe now starts and checks the internal battery. After approximately 2 minutes, it starts charging. 
This is indicated by the red LED of the FluoroProbe blinking shortly each 10 seconds. When the battery is 
charged, the green LED blinks. 

STATIONARY OPERATION OF THE BBE FLUOROPROBE 

Connect the power supply to the FluoroProbe as described above. Additionally connect the converter cable to 
the power supply and to the PC. The FluoroProbe can now be operated by the PC in “lab” mode. 

connector to the lab-cable 
(male) 

connector to the RS232 
cable (female) 

cable to the power supply 
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bbe++ Software 

 
The bbe++ software is delivered together with bbe instruments. It provides the following functions: 
 

• operation, control and calibration of bbe instruments 

• data analysis and display in tables and diagrams 

• export in different formats 

 
This chapter describes the general functions of the bbe++ software. The examples may show data or 
parameters of other bbe instruments. The data and parameters of your instrument can easily be handled 
accordingly. Whenever this manual deals with special features of a certain instrument, this will be explained in 
the special instrument chapter. 
The data and parameters of the instruments are stored in a database. A single database may contain the data 
of different instruments of the same type and also different types of instruments. 

Software Set-Up 

The software is stored on a CD delivered with the instrument. The latest version can also be downloaded from 
the bbe website after registration (http://www.bbe-moldaenke.de/log-in/ ). 
The Windows autorun function should start the installation automatically. If it does not, open the Explorer and 
click on setup.exe on the CD for installation. 
Welcome window: click “NEXT >” 
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Choose the destination folder and click “NEXT >” 

 

Choose a new start menu folder and click “NEXT >” 

 

Choose your preferred language and click “NEXT >” 
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Final success window of the bbe++ installation. Click “FINISH”. 

DESKTOP ICON OF THE BBE++ SOFTWARE 

The setup installs an icon for the bbe++ software on the desktop (if chosen during installation). 

BBE++ SOFTWARE IN THE START MENU 

The bbe++ folder in the start menu contains: 
� bbe++ software 

� installed manuals  

� link to the data folder of bbe++ 
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Software Update 

Updates of the bbe++ software and manuals can be downloaded from the bbe website http://www.bbe-
moldaenke.de after registration. 

Structure of the software 

The following menus are available in the bbe++ software. Whether a menu is displayed, depends on the access 
level set. 

• FILE contains all the input/output functions. 

• EDIT contains functions to copy data and graphics. 

• PARAMETER contains functions to set the parameters of an instrument and to adapt the parameters of data 

already measured. 

• VIEW contains functions to show and hide toolbars. 

• WINDOW contains functions to show the data in different types of tables and graphics as well as editors to 

change the layout (advanced functionality level only) 

• TOOLS contains options to change settings that influence the behaviour of the bbe++ software and the way 

of operating the instruments. 

• CALIBRATION contains the items to calibrate different bbe instruments (advanced functionality level only) 

• HELP contains information about the current bbe++ version. 
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General considerations for storing and displaying data and parameters in bbe++ 

WHAT IS STORED IN A BBE++ DATABASE? 

The measuring results and instrument parameters of different bbe instruments are stored. It is possible to 
retrieve the corresponding instrument parameters for each single result. 
In the so-called “Summary View” the serial numbers of the instruments and the time ranges for all data stored in 
this database are shown. This view can be used to select the desired data as well as the corresponding 
parameters for display. 
The database files are marked with the extension *.bdb (bbe database) 
 

WHERE IS THE DATABASE STORED? 

The database of bbe++ is stored in the standard application folder of Windows. The name of the folder depends 
on the operation system and the language. For example: C:\ProgramData\bbe++ in the Windows 7 English 
version. To access this folder easily, there is a link in the start menu called “Data directory”: 
 

 

HOW TO DISPLAY THE DATA? 

In the bbe++ software, different views have been pre-defined for each instrument: 

• graphics 

• tables 

• single dataset 

• data export 

 
User-defined views may be added as well.  

SIMULTANEOUS DISPLAY OF DATA OF DIFFERENT TYPES OF INSTRUMENTS 

After opening a database file, the data of different instruments of the same type may be displayed 
simultaneously. To display the data of another type of instrument from the same database file, this file can be 
opened more than once.  
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WHO CAN ACCESS TO THE PARAMETERS OF THE INSTRUMENTS? 

The bbe++ software has 2 access levels – basic functionality and advanced functionality. Depending on the 
different access levels, more or fewer menu items and parameters are shown. There are different settings for 
reading or writing access. The advanced functionality level can be password protected. 
 

DESKTOP OF THE BBE++ SOFTWARE. 

 

 

 
 
 
 

 
 
 
 
 
 

TOOLBAR 

Toolbar to navigate within the datasets. 

Toolbar 
 

Data table 

Graph 1 
 

Serial number, voltage of 
the battery, internal clock  
 

Graph 2 
 

Toolbar 
Instrument 
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TOOLBAR INSTRUMENT 

Toolbar to operate the instrument 

GRAPHIC- UND TABLE VIEWS 

User configurable windows with graphs and tables. 

SERIAL NUMBER, VOLTAGE OF THE BATTERY, INTERNAL CLOCK  

Display of the data of the connected instrument: serial number, voltage of the battery and internal clock. 
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The Menus 

FILE MENU 

The File Menu contains all the input/output functions.  

 

 

 

New 

Creates a new database file for data and parameters.  

 

If the new database already exists, the existing database is deleted after confirming the following message: 
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The new and empty database is displayed. 

 

New data can be entered in the database by importing or by starting a measurement. 

Open 

Opens an existing database. If there are already data in the database, the “Summary View” window appears. 
The type and serial number of the instrument can be chosen as well as the time range. The following example 
shows a database containing data from different FluoroProbes. 

 

Close 

Closes the active database. 

Import (FluoroProbe / AlgaeTorch / BenthoTorch)  

This function is used to import *.FLP files into the database. These files can be results transferred from the 
FluoroProbe to a USB stick or files generated by the first version of the FluoroProbe software. 
To import, please choose the file from the file system: 
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It is possible to select more than one file by pressing the shift key while selecting the file. 
FluoroProbe only: Afterwards choose how to apply the air pressure and hence the calculation of depth. 

AIR PRESSURE AS GIVEN IN FILE (FLUOROPROBE AND ALGAETORCH 100 ONLY) 

Air pressure was measured at the beginning of the measurement. This value is used. 

AIR PRESSURE FROM FIRST DATA SET (FLUOROPROBE AND ALGAETORCH 100 ONLY) 

The first measurement of air pressure took place in air. This is the appropriate selection if an autostart-plug 
without a PC was used (for further information see the FluoroProbe-manual). 

AIR PRESSURE (FLUOROPROBE AND ALGAETORCH 100 ONLY) 

Allows the entry of a constant value. To be used if the FluoroProbe was submerged for a longer time and unable 
to measure the air pressure by itself. 
In case of FluoroProbe data, the results are recalculated from the raw data after importing. 

The calculation procedure takes place in subsequent steps. After importing all data, a success message is 
shown. 
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Export (ASCII) 

This item exports the data as an ASCII file to load them into other programs. To select columns to be exported 
and the separator that is used, please see the description of the View Editor. The view editor allows the user to 
define different export formats for each instrument. All export formats of the current instrument are shown in the 
menu: 

 

The default export view is “Export all”. 
After clicking on “Export all”, the name and folder of the exported file can be selected. 
Hint: To transfer data to Excel, use the copy and paste feature in the “Edit” menu. 

Export (Database) 

This item is used to export parts of a database to a new (and smaller) one. The exported database can be read 
with bbe++ again. This might be useful when parts of the database are transferred via email. 
The currently selected data (“WINDOW � SELECT DATA”) are exported. 

Export (KMZ) – AlgaeTorch / BenthoTorch / FluoroProbe 

This item is used to export geo data from instruments with GPS receiver to be displayed in Google Earth. 

Export (ToxTest protocol) – AlgaeLabAnalyser only 

This item is used to export the results of toxicity tests conducted with the AlgaeLabAnalyser to Excel. 

Summary View 

Opens a new window that gives an overview of all the data and instruments in the current database: 

 

The database bbe++.bdb above contains data of two types of instruments: AlgaeTorch and FluoroProbe. 
The serial numbers and the point in time of the first measurement and the last measurement stored in the 
database are shown below the heading with the name of the instrument. 
The header of the window (bbe++.bdb [FP-18-03] :3 has the following meaning: 
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• the name of the database      bbe++.bdb 

• the serial number of the instrument 

for which the data in the data windows are currently shown  [FP-18-03] 

• the number of the window if there is more than one open window :3 

The summary view can be used to directly access the data or parameters of one of the listed instruments. To do 
so, use the right mouse click on the serial number: 

 

A selection of different periods and parameters are shown. After selecting one of the given periods, it is shown 
using the default view.  

 

For further information about the parameters window, please see the chapter Parameters. 

1. ... 2. ... 3. ... 

Names of the last database files opened for quick reload. 

Data Directory 

Opens the explorer with the current data directory to copy or rename the data base. This is the same function as 
in the start menu up to Windows 7. 

Exit 

Terminates the program. 
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EDIT MENU 

This menu contains commands to copy data/graphics from bbe++ and add them to the clipboard. 

Copy 

The content of the active window will be copied to the clipboard. Depending on the type of the active window, 
this is either a graph or a table. 
Tables can be pasted to EXCEL directly. 

HOW TO COPY DATA TO EXCEL: 

Use “WINDOW � SELECT DATA” to select the data you want to copy to EXCEL. Use the list window type that 
contains all the columns to be exported. Please note: only the columns from the active view are exported. 

• click on “EDIT � COPY”

• open Excel with an empty datasheet

• click on “EDIT � PASTE” in Excel
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Now the data can be used for all kinds off calculations within Excel. 

Edit Comment – advanced functionality only 

To edit the comment of one or more datasets mark the datasets in the table view. A dataset can be marked with 
a mouse click. Multiple datasets can be marked be pressing Ctrl key while clicking on the dataset required. 
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Go to Edit � Edit comments or use right click on the marked datasets: 

Enter the new comment for the selected data: 

Click OK: 

Delete Data – advanced functionality only 

To delete data, mark the datasets as described above. 
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Go to “EDIT � DELETE DATA” or use right click on the marked datasets: 

 

Click OK to delete the data. 

 

 

PARAMETERS MENU 

 

This menu contains commands to: 

• display parameters of datasets stored in the database (History) 

 

The following items are not available for AlgaeTorch and BethoTorch: 

 

• apply a user-defined selection of parameters to an instrument (Template) 

• display and change parameters in the instruments (online) 

• recalculate the datasets in the database with another set of calibration parameters (Recalc) 

 

Each selection in the menu leads to one tab of the Parameters window. 

Please note: 
Only parameters of the current type of instrument are shown. 
It depends on the user level, whether a parameter is shown or not. The higher the user level, the 
more parameters are shown. 

For example of parameter listings for user levels, please see the examples below. 
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Access level “advanced functionality”: 

 

Access level “User”: 

 

Depending on the parameters and on the access level, the parameters are read only  or read and write . 
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Overview 

 

TYPE OF OPERATION 

The selection of the type of operation corresponds to the commands in the menu. Depending on the selection, 

different types of operations can be done. 

EXPLANATIONS 

Gives a short introduction to what can be done. 

BUTTONS 

Export: exports the current parameter set to another database for recalculation 

Clipboard: copies the current parameter set to the clipboard to paste it into another application such as Office 

Word or Excel etc. 

Upload: sends the parameters to the connected instrument 

Matrix: shows all the calibration parameters of the connected instrument in one window. 

NAME OF PARAMETER SET 

Each set of parameters can be identified by its time and date. Edited parameter sets or templates have an 

additional name given by the user. 

Command buttons 

Type of operation 

Explanations 

Type of Parameter 

Name / Date of the parameter set 

Values 

Type of parameter set 
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TYPE OF PARAMETER 

Each tab shows the parameters of a specific topic. 

VALUES 

Shows the current values of the parameters. Depending on the type of operation the value can be edited. 

TYPE OF PARAMETER SET 

Indicates the type of parameter set: 

Original: this parameter set has been used originally for a measurement, it cannot be deleted. 

Adapted: this is a parameter set has been adapted by the user, it can be used to recalculate the datasets. 

 

Shows the current values of the parameters. Depending on the type of operation the value can be edited. 

History – advanced functionality only 

Displays the parameters of the active dataset. 
The history is also available on the Context Menu in table view: 
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All parameter sets in the database can be displayed. To choose one parameter set, select the date from the 
drop-down box: 

 

 
 
 
 

TEMPLATE BUTTON 

The „Template“ button is used to generate a new template from the current parameter set using different 

schemes. A scheme is a predefined selection of parameter – for example all the fingerprints. The parameter of 

the selection will be copied to a new template. Parameters that are not in the scheme will not be copied.  
This is more convenient, than entering the parameter to a new template by hand. 
The new template can be edited as any template. 
First step is to choose the scheme with the selection of parameters. 

 
 
Giving the new template a name: 

 
 
Afterwards the new template can be displayed and edited. It can be used as any other template.  
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Templates  

The purpose of parameter templates is to store a partial set of parameters (for example offsets or measuring 
times or air pressure handling) in one set. This makes it easy to apply different setting to an instrument, 
depending on the location. 
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CREATE A NEW TEMPLATE 

Click new, all parameters of the current user-level are shown and empty. To change an entry, double click on 

the value box. When entering the first value, a name for the parameter set is requested: 

 

The name and date is shown in the headline of the table: 

 

Depending on the type of parameter, either an input box or a drop-down box is used: 

 

 

Click OK to store the template. 

UPLOAD A TEMPLATE 

1. connect the instrument to the PC (“TOOLS � CONNECT COM PORT”) 

2. go to “PARAMETER� TEMPLATES“ 

3. select the template from the drop-down box: 

 

4. Click “UPLOAD“: 

bbe++ loads all the parameters from the instrument: 
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and sends the changed parameters back to the instrument. 

 

All parameters not defined in the template will not be overwritten in the instrument. 

DELETE A TEMPLATE 

• select the template to be deleted 

• click delete 

Online  

The section “Online” is used to change the parameters of the instrument. 

This item is available as soon as an instrument is connected. 

1. connect the instrument to the PC (“TOOLS � CONNECT COM PORT”) 

2. go to “PARAMETERS � ONLINE” 

bbe++ loads all the parameters from the instrument: 
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The parameters are shown: 

 

3. change the parameters as described in the “Template” section. 

4. click OK to upload the new parameters 

5. Use the “clipboard” button to copy all the parameters to the clipboard and paste it into EXCEL for 

example: 
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Recalc  – advanced functionality only 

The recalculation option is available in all instruments except for the AlgaeTorch. For the BenthoTorch the 
recalculation is limited to the recalculation by using another parameter set from the BenthoTorch. Editing of the 
parameter sets and templates are not available for the BenthoTorch. 

 

 

To change the settings and recalculate the results, the following steps have to be executed: 

1. Select the instrument and time period (“WINDOW � SELECT DATA”). 

2. Go to “PARAMETERS � RECALC” 

3. Select a new dataset from the dropdown box or create a new one by editing a copy. Please note: only copies 

of an original parameter set can be edited. These sets are marked with “adapted”. 
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4. To create a new parameter set (not in the BenthoTorch), select one, click “CREATE COPY” and enter a name 

for this parameter set. 

  

 

5. Select the new parameter set and edit the settings as described in the “Template” section. Please note the 

number and type of parameters shown depends on the user-level. Only the parameters marked with the 

green symbol can be changed. 
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6. Click “APPLY” to store the changes in the new parameter set. 

7. Click “RECALC” to recalculate the data with the new parameters. 

8. Recalculated data sets are marked in table view at the beginning of each line: 

 

RESTORE DATA WITH ORIGINAL PARAMETERS  

The original data of the measurement is not deleted by the recalculation. It is always possible to see the results 

calculated with the parameters valid when the measurement was taken. 

To restore the original data: 

1. Select the instrument and time period (“WINDOW � SELECT DATA”) 

2. Go to “PARAMETERS � RECALC” 

3. Click “UNDO”. Please note: This item is only available when recalculated data are available in the selected 

time period. 
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DELETE ADAPTED PARAMETER SETS 

To delete adapted parameter sets click “DELETE”. All unused parameter sets will be shown. Parameter sets that 
are in use cannot be deleted. 

 

Select the parameter sets to be deleted and click “DELETE”. 

Matrix view 

For the parameters of the FluoroProbe and the AlgaeLabAnalyser there is another window available to edit the 
parameters. It is shown when the button “MATRIX” is pushed: 

 

Changing any parameter here has the same effect as changing the parameter in the standard view. 
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VIEW MENU 

 

Toolbar 

Displays or hides the toolbar. 
The toolbar allows quick access to some important instructions: 

 
 
 
 
 

Status Bar 

Displays or hides the status bar. 

 

 

Measurement 

Displays / hides the measurement toolbar.  
The toolbar “Measurement” is different for each type of instrument. It allows quick access to functions such as 
starting and stopping the measurement or retrieving the parameters.  
The measurement toolbar of the FluoroProbe is given here as an example: 

 

 

Macro 

The toolbar “Macro” contains buttons to access to the user-defined view macros. For details, please see the 
chapter “TOOLS” � “SETTINGS” � “MACRO MANAGER”. 

 

For the grey buttons, no macro has been defined. 

New database 

Open database 

Copy graphic or table to clipboard 

Open the Settings dialog 
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Data Navigation 

The toolbar “Data navigation” contains buttons to navigate within the data. “One page” corresponds to the time 
scale of the Concentration vs. Time graphs. 

 

� go to the first dataset 

� one page backwards 

� one page forwards 

� go to the last dataset 

 

Period 

The toolbar “Period” contains buttons to scale the time axes to a given value: 

 

� 1 hour 

� 6 hours 

� 1 day 

� 7 days 

Session 

The toolbar “Session” contains buttons to navigate from one measurement to another. One measurement is 
defined as a number of consecutive data sets that do not differ in the point of measurement by more than a 
given value. This value can be set in “TOOLS” � “SETTINGS” � “DISPLAY”. 

 

Connection State 

The toolbar “Connection state” shows the status of the connection to the connected instrument: 

 

The colour indicates the status: 
Black:    Not connected, the PC has not tried to establish a connection 
Yellow, blinking Not connected, the PC is trying to establish a connection 
Green   Connected 
 
This is not a button, but an indicator only. 

Auto-Update 

If auto-update is activated and a new data-set is generated during the measurement, this data-set is shown in 
the graphic or list window. If the displayed period does not contain this current point in time, the displayed period 
is changed automatically, so that the latest data-set is shown. 
If auto-update is deactivated, the displayed period does not change. This is useful when doing data analysis 
during the measurement. 
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Window – Advanced functionality only 

This menu contains commands to show, arrange and edit different views to display the data. 

 

New Table Window 

Opens a new window and displays the data according to the selected window type. 

 

(See below) 
Please see the list window “Concentration” of an AlgaeTorch as an example. 

 

New XYGraph Window 

Opens a new window and displays the data according to the selected window type. 

 

There are some view types pre-defined for each instrument. It is also possible to add new window types by 
using the view editor. 
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The following diagram shows the development of different algae classes measured with the bbe FluoroProbe.  

 

New Single Value View 

Opens a new window and displays the data of one data-set according to the selected window type. 

 

The data-set is shown in larger digits to help the user read the display even in bright sunlight. The latest data-
set is shown. 
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The “Single Value View” can be adapted to the screen by changing size and/or proportion of the window: 

    

 

Cascade 

Arranges the windows one behind the other. 

Tile Horizontally/Vertically 

Initiates the organization of the screen into mutually non-overlapping frames. 

Select Data 

The “Select Data” window can be used to select data of a specific instrument and a specific time range from the 
current database. 
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Type: shows the types of instruments available in this database. 
Unit: shows the serial numbers of the type of instruments chosen above available in this 

database. 

TIME RANGE 

Selects the time range of data to be selected. It is possible to select a fixed time range such as “last month” or 
to do a manual selection by entering a range FROM “date” TO “date”. 

Hint: Further selections can also easily be made in a graphic window. 

 

After selecting the time range, the data is shown in the default view. 

 

View Editor 

The View Editor is used to generate your own table or graphic window type as well as a template for the export 
to text files. The View Editor is an assistant that leads through the whole process. 
When starting the View Editor, the current view is selected automatically to be edited or used as a template for a 
new view. Other views may be selected. 
For each instrument there are pre-defined views. These views can be edited but not deleted. Changes in pre-
defined views can be reset to their original status. User-defined views can be edited and deleted. 

GENERATING AND EDITING A TABLE VIEW WINDOW 

To explain the function of the View Editor, in the following steps a table view showing date/time, total chlorophyll 
concentration, Bluegreen concentration and depth is generated as an example.  
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View Selection 

1. Open the view editor: 

        

2. Choose the type of instrument the view is to be used for (in the example “FluoroProbe”). 

3. Choose the type of view that is to be generated or edited (in the example “Table view / single value 
view”). 

4. Choose one existing view to edit or as a template for a new one. 

In case of a pre-defined view, the view can be reset to the original status (“RESET”). 
In case of a user-defined view, the view can be deleted (choose a custom view and click “DELETE”). 

5. Click “NEXT”. 

Field Configuration 

This window shows all available data of the selected instrument. The left column shows the data that is currently 
not used in the chosen view. In the right column are data that will be displayed in the resulting view. The order in 
the right column corresponds to the order in the table. 

 

6. Click on “Green Algae [µg/l]” and “ REMOVE” to remove the concentration of green algae from the 
view. 

7. Repeat with all entries but “Date/Time (date)”; “Bluegreen [µg/l]”, “Total conc. [µg/l]” and “Depth [m]”. 

8. Click on “Total conc. [µg/l]” and ”UP” to change the order. 
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9. Click “Next”. 

 

General Properties 

The General Properties page allows the user to change the background color of a “Single value” view. 

 

10. Click on the color picker box behind „Background color“ and choose a new color. 

 

The chosen color is now shown in the color picker box 
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Example of a change in background color: 

   

Save View 

11. Enter a name for the view. 

 

12. Click “OK” to confirm. The current data is then shown with the new view. 
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13. The new view is now available in the Window menu. 

 

GENERATING AND EDITING A GRAPHIC VIEW WINDOW 

To explain this function, in the following steps a graphic view showing date/time and total chlorophyll 
concentration is generated as an example. 
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View Selection 

1. Open the view editor: 

    

2. Choose the type of instrument the view is to be used for (in the example “FluoroProbe”). 

3. Choose the type of view that is to be generated or edited (in the example “Graphics view”). 

4. Choose one existing view to edit or as a template for a new one (in the example “Conc. / depth”). 

In case of a pre-defined view, the view can be reset to the original status (“RESET”). 
In case of a user-defined view, the custom view can be deleted (“DELETE”). 

5. Click “NEXT”. 

Independent Axis 

6. Choose the design according to the given examples (in the example Y-Axis) 
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Field Configuration 

7. Select the data for the axis chosen and click on “ADD�”. Only one of the available entries is possible (in 
the example “Depth”) 

 

8. After choosing one entry all other entries vanish. Removing the entry by clicking “REMOVE” brings 
back all available entries. 

 

9. Click on „PROPERTIES“ 

Axis Properties - first axis 

Some properties can be set for each axis. For the first axis, this is the position and the direction. 
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Normally the first axis is on the lower or left side of the graph. The direction is normally defined as: 
X-Axis: left side � low values right side � high values 
Y-Axis: bottom � low values top � high values 
To display e.g. chlorophyll concentration versus depth, it is easier to use the top position of the X-axis and to 
invert the direction of the Y-axis for the depth. Please see the following example: the first picture shows the 
standard settings, the second one with a direction-inverted Y-axis and inverted position of the X-axis. 

 

 

10. Click “OK” to confirm the settings. 

11. Click “NEXT”. 

12. Now the data and settings for the other axis can be selected. 
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Field Configuration - second axis 

 

13. After selecting one type of data, only those types which have the same unit(s) remain in the right 
column. 

 

14. For example, “Total chlorophyll concentration” and “Bluegreen” have to be selected here. 
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Axis Properties - second axis 

For the second axis, the properties can be set as shown above. Additionally available scaling options are: 

 

Manual scaling: enter fixed values for the minimum and the maximum of this axis - enter 0 for both to 
disable this feature. 

Auto-scale on: enables the auto-scaling feature - the axis will be scaled so that all selected data are 
visible. 

Auto-scale limits: these settings are used to obtain a nice looking graph in two special situations:  
� datasets with very low noise: 

In the auto-scaling mode, the graph looks as if there are extreme variations, but the 
range is very small due to the auto-scaling. In this case, it is better to use the option: 
lower limit: lower than and 
upper limit: higher than  
This leads to a minimum span in the graph. 

� datasets with outliners: 

In this case, it is difficult to analyze the data because the auto-scaling generates a 
high span value. To prevent this, please use: 
lower limit: higher than for outliners with low values  and 
upper limit: lower than for outliners with high values 
This leads to an optimized span in the graph. 

15. Click “Next” 

Attributes 

This sets the color and size of the dots and lines as well as the color of the background. 
16. Set the value in the attributes window according to your needs. 
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Pixel number: enter the dot size of the value points.  
Background color: click on the colored button to change the background color of the graph. 
For illustration, please see the examples with connected and unconnected dots, different sizes and background 
colors. 
Different dot sizes: 

    

Different background colors: 
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Column Attributes 

Select a dataset. 
Color: select a dataset and click on the colored button to change the color of the dots. 
Connected: check the box to connect the dots in the graph. 

 

Hint: The data points are not connected if the time of measurement differs more than the given 
value in “TOOLS ���� SETTINGS ���� DISPLAY”. 

 
Different dot colors: 

    

Unconnected dots / connected dots: 

    

17. Click “Next” 
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Save view 

18. Enter a new name for the view. It is not possible to edit pre-defined views. Please store a view based on 
a pre-defined view with a new name. 

 

19. The current data is shown using the new view after clicking “OK”. 

 

GENERATING AND EDITING AN ASCII EXPORT 

View Selection 

1. Open the view editor: 

 

2. Choose the type of instrument the export is to be used for (in the example “AlgaeTorch”) 

3. Choose the type of export that is to be generated or edited (in the example “ASCII export”) 
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4. Choose one existing view to edit or as a template for a new view. The delete button is used to delete a 
view. It is not possible to delete pre-defined views. 

5. Click “NEXT” 

Field Configuration 

This window shows all available data of the selected instrument. The left column shows data which are not 
currently used in the chosen view. In the right column are data that are to be displayed in the view. The order in 
the right column corresponds to the order in the table. 

 

6. Select the required datasets from the right column. Use the up and down buttons to determine the order 
of the data in the export table. 

7. Click “Next”. 

 

 

8. Define separator and end of line characters according to the needs of the importing software. 

9. Click “Next”. 
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Save View 

10. Enter a new name for the view. It is not possible to edit pre-defined views. Please store a view based on 
a pre-defined view with a new name. 

 

11. The new view is now available in the “File” menu. 

 

Comment Fields 

For each type of instrument, special comments can be defined. These comment fields can be used at the 
beginning of the measurement. The comments names and types can be defined within this dialog. 

 

Type of instrument: the type of instrument is defined in the settings “TOOLS � SETTINGS � ACCESS“. 
Used: if tagged, the comment can be used at the start of the measurement, otherwise the 

comment is hidden. 
Description: name of the comment 
Type: “Text” allows entry of text, “Number” allows digits only; this is relevant for the way the 

comments are sorted in a list view.  
Template: stores the comment definition to transfer it to a new database; the transfer is done 

when opening a new database. 

1. ... 2. ... 3. ... 

Shows all the currently opened windows. 
 

TOOLS 

Menu (advanced functionality) 
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Menu (basic functionality) 

 

Settings 

Here, all the preferences for the general functionality of bbe++ can be set. 

DATABASE 

The ‘Database’ tab shows the currently used database. The checkbox can be used to open this database after 
starting bbe++. We recommend you to store all the data in the same database. 

 

Automatic start of measurement 

For continuously working instruments (AOA or FluoroProbe / AlgaeTorch) the software can be configurated to 
start the measurement directly after starting the software. The feature can be used to ensure, that the 
measurement starts again after a power fail. 

Auto Archive 

If there are many datasets in the database, navigation in the database becomes slow. The “Auto Archive” 
function automatically archives older data in the database. If there are data older than – in the example – 60 
days, the auto-archive function is started. Only datasets that are a maximum of 30 days old remain in the 
database.  
The archived data is written in a database similar to an exported database. The name corresponds to the date 
of the first dataset in this database. 
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DISPLAY 

Enter the time period which defines the maximum interval between two measurements of the same series. The 
setting is used for the “Next measurement” button in the toolbar. 

 

Next and previous measurement buttons in the toolbar.  

 

Furthermore, this setting is used to control the drawing of lines between two dots. If the interval between two 
measurements is shorter than the given interval, a line is drawn – otherwise not: 

 

interval set to 10 minutes 



The Menus 

bbe FluoroProbe manual   page 72 

 

ACCESS 

Depending on the access level selected, the software shows more or fewer options. The main difference is the 
number of items shown in the menus and the number of parameters shown. 
If an instrument with editable parameters is connected, the same setting is maintained for editing. 

 

User-levels: 
Level     Access 

Basic functionality • Just basic operation of the instrument 

• Measurements with pre-defined parameters only 

Advanced 
functionality 

• All menus accessible / all parameters customizable 

 
The “Advanced functionality” level can be password-protected. As soon as the checkbox is ticked, a password 
can be entered. Afterwards the password is required to enter the Advanced functionality level. 

Minimal interval set to 1 minute 
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Please note: 
The “Advanced functionality” level remains until “Basic functionality” level is chosen again. 
Even when restarting the software, the “Advanced functionality” level and a given password 
will still be valid. 

 

Default Device 

The bbe++ software is able to control different types bbe instruments, but only one type at one time. The type of 
instrument is entered here. Various settings within the bbe++ software can only be made for the default type 
instrument. To make entries for an other type of instrument, the default type has to be changed before. 

Offline Mode: 

Choose the offline mode to display data of different type of instruments. If the offline mode is active, no 
measurement is possible. 

MACRO MANAGER 

The bbe++ software provides the option to store the arrangement of the view windows. One of the stored views 
can be used as the default view automatically displayed after starting bbe++. 

  

 
To generate a new view macro: 

1. Arrange the windows. 

2. Enter the name of the new view. 

3. Check the “Use at program start” box as required. 

4. Confirm. 
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LOGGER SETTINGS 

The logger settings are used in case of problems with the bbe++ software. Please ask the bbe service for 
advice. 
Depending on the checked options more or less information is stored in the file “error.log” in the program folder 
of bbe++ software. 

 

SHORTCUTS 

With the F8 key, one single view can be retrieved. Please enter the single view macro to be used for this. 
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F8 shows the selected macro 

LANGUAGE 

This tab shows a list of the available languages of the bbe++ software. To change the language, choose the 
language you wish and click “OK”. The bbe++ software must be restarted for the changes to take effect. 
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IO MODULS 

This item is used to connect an IO module (for example 4-20mA or relay outputs) to the PC.  

 
• the COM port can either be chosen from the drop down box or the software can search all COM ports 

for the selected instrument. 

• once an instrument has been found the COM port is stored for the next use. 

• To configurate the devices goto Tools -> device -> … . This item is not available for all instruments. 

 

Enable advanced/basic functionality 

Change between advanced and basic functionality. See also Tools -> Settings -> Access. 
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Connect COM port 

 

This item is used to connect an instrument to the PC. 

Please note: 

• bbe++ is looking for an instrument of the selected type only (Tools � Settings � Access). 

• the COM port can either be chosen from the drop down box or the software can search all COM ports 
for the selected instrument. 

• once an instrument has been found the COM port is stored for the next use. 

Device 

The “Device” submenu varies depending on the selected type of instrument. Each type has its own submenu. 

DEMOMODE 

To switch the bbe++ software to the demo mode select FluoroProbe (Tools -> Settings -> Access) and 
disconnect all instruments. Click on “DEMO mode” in the device submenu. Now, the software can be operated 
as if a FluoroProbe were connected. Some procedures such as calibrations are limited in function. 
To reset the demo mode, please restart bbe++. 

 

Once the DEMO mode is selected, the submenu changes to the FluoroProbe entries: 

 

SQL Script 

This function can be used to run an SQL script on the database to reorganise it or to do some special 
calculations. The SQL script is provided by bbe Moldaenke as the case arises. 
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FLUOROPROBE SUBMENU 

 

 

First measurement as air pressure: 

Check to use the result of the first measurement as air pressure. This applies only when you start the 
measurement by bbe++ (not when using the AutoStartPlug). 
 

Enter comment at start of measurement: 

Check to enter one or more comments when starting the measurement procedure. 
 

Force import of all data 

The import starts with the latest data. If there are data already in the database, the import stops. The software 
does not look for older, not-imported data to reduce the importing time. 
 
If older data are to be imported, this flag has to be activated. If activated, all data from the FluoroProbe are 
imported. Datasets already in the database are skipped. 
 

Delete data 

Deletes all data in the FluoroProbe. 
 

Synchronize device with PC time 

To set the clock of the FluoroProbe, synchronise it with the clock of the PC by activating “Synchronize with PC”. 
 

Get data from device 

Imports parameters and the latest data that have not been imported yet. The import starts with the latest data. If 
there are data already in the database, the import stops. The software does not look for older, not-imported data 
to reduce the importing time. 
 
The import options described here refer to the maximum 1,754 data sets stored in the memory of the 
FluoroProbe. Further data can be downloaded from the FluoroProbe using the USB adapter. 

Air pressure 

Measures and stores the current air pressure. This reading is used to define the pressure at the surface of the 
water. Please note: 100mBar change in the air pressure leads to a misreading in depth of about 1m. 
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Parameters utility 

Receiving the complete parameters set from the FluoroProbe and sending a Parameters file to the instrument. 
This is supplied by the bbe service in most of the cases. 
 

 

CALIBRATION 

 

 

Sensors  

Please use the “Sensor” item to calibrate the temperature sensors and the pressure sensor. The following 
window shows the actual data measured by the FluoroProbe. To calibrate, just enter the correct value and press 
the corresponding “Apply” button. The actual value should then be correct (does not work in DEMO mode). 
 
 

 
 

TEMP. FLUOR. / TEMP. LEDS 

Internal temperature sensors. This calibration should only be performed by trained personnel.   

PRESSURE  

Calibration of the pressure sensor. If other pressure sensors are used at the same time, the pressure sensor of 
the FluoroProbe can be adapted to other sensors by entering the result of this sensor and pressing “Apply”. 
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BATTERY VOLTAGE 

Calibrates the measurement of the power supply voltage. 
 

Sample temperature 

The sample temperature can be calibrated by a two-point calibration. To do so, two different containers with 
water at two different temperatures are needed. Both temperatures should cover the common range of the 
samples. The difference must be more than 10°C. 
 

 
 
For calibration, the FluoroProbe has to be submerged in the first container or canister and the temperature of 
this canister has to be entered in the field “First calibration point”. If the current temperature display is stable, the 
value can be stored by clicking the corresponding “Hold” button. During the calibration measurement the 
FluoroProbe has to be moved permanently. This procedure has to be repeated with the second temperature. 
 
Afterwards the resulting new offset and gradient are displayed. The results can be written to the FluoroProbe by 
using the “Apply” button. Using “Cancel” means all results are not saved and the previous settings are used. 
 
 

Transmission  

Performs a calibration at the offset of the transmission measurement. This is the value that is measured if pure 
water (100% transmission) or no transmission (0%) is present.  
To calibrate 100% transmission, pure water is required. 
 
To obtain the 0% value, the protective light shield of the FluoroProbe has to be dismounted and the detector 
window has to be covered, e.g. with a sheet of black paper. 
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START 

Starts the calibration.; 10 measurements are taken and averaged. 

CANCEL 

Cancels the calibration. 

APPLY 

Sends the results of either the offset or of the gradient calibration to the FluoroProbe 

MEASUREMENT 

The number of measurements is counted during the calibration. 

OLD OFFSET / GRADIENT: 

Offset / gradient before calibration 

NEW OFFSET / GRADIENT 

Offset / gradient after calibration 
 
 

Offsets (filtrated / distilled) 

The offset is the signal without algae that has to be subtracted during the measurement. 
If the FluoroProbe has the capability to detect yellow substances (all probes from Series 7 and later and all 
updated probes), two offsets have to be calibrated.  
 
1. The offset in distilled water. This water has to be free of algae and free of yellow substances. This offset is 

used when the determination of yellow substances is switched on. The concentration of yellow substances 
is determined during the measurement.  

2. The offset in ultra-filtrated water. This water has to be free of algae. This offset is used when the 
determination of yellow substances is switched off. The concentration of yellow substances is “in” the offset 
and so filtrated sample water has to be used for the offset. 

 
Please submerge the FluoroProbe into the type of water and start the calibration. 
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MEASUREMENT 

The number of measurements is counted during the calibration. 

OLD 

Offset before the calibration 

NEW  

Offset after the calibration 

TRANSMISSION 

Here the current transmission is displayed. This is to check the measurement and to see whether there are air 
bubbles in front of the window which may affect the measurement. During the offset measurement, the 
transmission should be around 100%. 

START 

Starts the calibration; 10 measurements are taken and averaged. 

CANCEL 

Cancels the calibration. 

APPLY 

Sends the results of the calibration to the FluoroProbe. 
 
 

Fingerprints 

The calibration of the fingerprints is necessary to obtain the specific spectra of the algae divisions. To 
recalibrate an existing algae class, choose the “Fingerprints” item.  
 
For calibration of a new algae division, please do the following first: 

• obtain parameters from the “Probe” menu 

• enter a new name in the “Parameter of fit” page  

• send the new name to the probe (press “Send” button) 
 
After choosing the “Fingerprint” item, the following window appears: 
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Please enter the algae class you want to calibrate by pressing the algae class dropdown button and enter the 
concentration of the calibrating algae solution from which you wish to calibrate the bbe FluoroProbe. 
 
NOTE: the concentration of yellow substances is not given in µg/l, but in relative units, which means that the 
indicated concentration is relative to the content in the water used for the calibration. 
 
Depending on whether the algae used for the calibration are diluted with distilled water (e.g. without any other 
fluorescent matter) or in filtrated sample water, click the corresponding box. The FluoroProbe software will 
choose either the offset of distilled  water or the offset of ultra-filtrated sample water. 

ALGAE CLASS 

Please enter the name of the algae class to be calibrated. 

CONCENTRATION 

Please enter the concentration of chlorophyll-a in the solution. 

START 

Starts the calibration; 10 measurements are taken and averaged. 

CANCEL 

Cancels the calibration. 

APPLY 

Sends the results of the calibration to the probe. 

MEASUREMENT 

The number of measurements is counted during the calibration. 

TYPE OF OFFSET 

Choose the type of dilution water of the algae solution. 

OLD FACTOR 

Factors of the fingerprint before the calibration. 

NEW FACTOR 

Factors of the fingerprint after the calibration. 

TRANSMISSION 

Here the current transmission is displayed. This is to check the measurement and to obtain a message 
regarding air bubbles in front of the window. In algae solutions with about 30µg/l the transmission is 85-95% 
depending on the type of algae. 
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Correction factor 

 

CORRECTION OF A FINGERPRINT/APPLY NEW FINGERPRINT 

This item allows the correction of a specific fingerprint with a factor. If one algae class is under- or 
overestimated compared to the reference value, the fingerprint can be changed automatically. Entering for 
example the factor 2 will double the result for the chosen algae class. After entering the number, the new 
fingerprint will be displayed. Use the “Apply” button to send it to the sensor. 

FACTORY SETTINGS / APPLY FACTORY DEFAULTS 

This option can be used to reset a specific fingerprint to the factory settings. This feature is only available in 
sensors with internal software of 1.96 or higher. Otherwise, this option is greyed out. 
 

 

HELP 

 

About … 

Displays the start-up screen. 
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bbe++ manuals … 

List of currently installed bbe++ manuals. Depending on the selection made during the installation, there may be 
manuals in different languages and for different instruments. 
 

The Views 

TABLE VIEWS 

A table view is opened by “WINDOW � NEW TABLE VIEW � TABLE VIEW NAME“.  

 

Within the list view, the right mouse button offers detailed information about the selected data set. 
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History of Parameters 

HISTORY OF PARAMETERS shows the corresponding parameters for the given instrument and time. For details, 
see the description of the data menu. 

 

Edit comment 

EDIT COMMENTS allows the user to change the comments of a specific data set retrospectively. 

 

The dropdown list contains previously entered comments (if applicable). 
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Data selection 

To add or remove columns from the list view use “Data selection”. The dialog is similar to the dialog of the View 
Editor. 

 

Please select or deselect the columns. The list view is updated immediately. 

Sorting of the list view 

The list view is sorted by date/time. It can be sorted by any other column by clicking on the header of the 
column. Clicking twice leads to the reversed order. 
 
Sorted by time/date ascending: 

 

 
Sorted by time/date descending: 
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Sorted by green algae descending: 

 

XY GRAPH VIEWS 

Features of the XY graph view: 

1. Select data of interest 

2. Scaling of the axes (right click) 

3. Display of the corresponding parameters (right click) 

4. Editing a XY view, to change colours the type of graph. 

5. Navigation within the data 

Select data of interest 

Please click and draw the mouse to select the required data. 

 

A pop-up window is shown to choose the axis to which the selection is to be applied. 
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X only only the selection on the horizontal axis is applied. 
Y only only the selection on the vertical axis is applied. 
X and Y the selection on the horizontal and the vertical axis is applied. 

 

X only applied 
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Right-click menu 

 

Y only appliedMinimal 

X and Y applied 
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Features: 

� adjust the scaling . 

� activate and deactivate of the autoscaling feature. 

� show the parameters of a single data-set. 

� return to the default scaling. 

Scaling of the axis 

By default, scaling is done automatically. This means, all datasets of the selected period are displayed. To have 
a closer look at the data, it is sometimes useful to change the scaling. In the right-click menu, there is a “Scale 
axis” option: 
In case of a time axis, the scaling tab of this axis is as follows: 

 

The first and last point in time have to be entered. 

Hint: For more information on scaling an axis please see the "window" section in this manual. 

In case of a “non-time axis”, more possible adjustments are available: 

  
 
Manual scaling: enter fixed values for the minimum and the maximum of this axis - enter 0 for both to 

disable this feature. 
Auto scale limits these settings are used to obtain a nice looking graph in two special situations:  
 

• data sets with very low noise: 
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In the auto-scaling mode, the graph looks as if there are extreme variations, but the range 
is very small due to the auto-scaling. In this case, it is better to use the options: 
lower limit: lower than and 
upper limit: higher than  
This leads to a minimum span in the graph. 
 

• data sets with outliners: 

In this case, it is difficult to analyse the data because the auto scaling generates a high 
span value. To prevent this, please use the 
lower limit: higher than for outliners with low values  and 
upper limit: lower than for outliners with high values 
This leads to an optimised span in the graph. 

Autoscaling  

Enables the auto-scaling feature. The axis will be scaled so that all selected data are visible. 

Parameters 

Show the parameters of the data-set 

Default scaling 

Click here to undo all the changes in the scaling options. 
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Parameters 

Process parameters 

 

 
 

Enter comment 

If set, a comment can be entered when starting the measurement. 

Air pressure from first measurement 

If set, the air pressure reading for the calculation of the depth is taken from the first dataset. If not set, it has to 
be measured separately. 
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Common parameters 

This section contains parameters to control the measuring procedure. Parameters as measuring interval or 
measuring duration are located in this section. 

Warm-up time 

During the warm-up time, the LEDs are on but the measurement has not yet started. 

Measurement interval 

This is the interval between the start of one measurement to the start of the next measurement. For online 
measurements without external power supply, the interval can be set to save energy. In this case, please use 
the power-down option. 

Number of measurements 

Performs a given number of measurements and stops afterwards. Only valid if continuous measurement is 
disabled. 

LED measuring duration 

Duration of the LED brightness measurement. Only valid for FluoroProbes up to series 17. 

Measurement time 

Duration of a single measurement. The longer the time, the more stable the results are. 

Send results 

If set, the results of each measurement will be send to the PC directly after the measurement. Please disable for 
maximum measuring frequency. 
In case ‘Send results’ is set to ‘off’, please be aware that you will not receive results directly during 
measurement to bbe++ even when you started the measurement by way of bbe++. In this case, please 
download the data from the FluoroProbe later by use of the USB adapter and import the flp file in question to 
bbe++. 
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Power-down after measurement 

If set, the FluoroProbe switches off after each measurement to save power. This makes it possible to collect 
data from some days or weeks depending on the measuring frequency. 

Store results 

If set, the results will be stored in the internal data logger 

Start measurement on power-up 

If set, the FluoroProbe starts a measurement after starting. This is set when using the FluoroProbe as a stand-
alone unit without any PC. 

Serial number 

Shows the serial number of the FluoroProbe. 

Software version 

Shows the software version of the firmware. 

Fit parameters 

 

 

Name 

The names of the algae classes can be entered here. 

Salinity 

Enter the salinity of the water to enhance the calculation of the depth. 
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Enabled for fit flag 

Each algae class can be enabled / disabled. Please note: the maximum number of activated algae classes is 5 
(including yellow substances). 

Are Yellow Substances 

If set to yellow substances (on), the measured concentration is not added to the total algae concentration and 
the displayed unit is r.u. 

Ultra-filtrated water offsets 

Displays the results of the offset calibration of ultra-filtrated sample water. 
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Distilled water offsets 

Displays the results of the offset calibration of distilled water. 

Fingerprints 

Displays the results of the algae class calibrations. 
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Standard deviations 

Standard deviations of the fingerprints of each algae class. This standard deviation refers to variations within 
one specific algae class. The greater the standard deviation, the less important the measured value for this 
algae class 

Date of calibration  

Date of the last calibration at bbe Moldaenke. 

Global correction factor 

Set to 1 by default. All algae concentrations are multiplied by this factor. 

Cell factors  

Factor to convert the concentration of the algae classes to cell counts. 

Measurement parameters 

 

Air pressure 

Displays the air pressure. This parameter is set when clicking the “Set air pressure“ button before starting the 
measurement. The parameter is used to calculate the depth. 

Offsets and gradients of transmission, pressure, temperatures and voltage 

Displays the results of the calibrations of the measurands. 
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Required values of the LEDs 

Values for the basic calibration of the FluoroProbe 

Temperature correction 

Temperature correction factors for the given temperature ranges. 

Turbidity parameters 
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Turbidity compensation 

Setting to activate and deactivate the turbidity compensation. 

FTU polynomial factors 

Factors to convert transmission in turbidity 

FTU reflection/mitigation compensation 

Factors to adjust the turbidity compensation. 
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bbe FluoroProbe Procedures 

Measuring Procedure 

The FluoroProbe was calibrated before delivery with the bbe standard algae types and yellow substances. In 
case of the presence of algae types that have not been calibrated or in case of different types of yellow 
substances, the FluoroProbe needs to be calibrated to these special needs first. This is most important if only 
low concentrations of algae (< 10µg/l) are present. 

MEASURING PROCEDURE WITH CONNECTED PC 

• connect the bbe FluoroProbe and the PC with the measuring cable / RS485 to USB converter cable, making 
sure that the connector has been greased sufficiently and the internal rechargeable battery is charged. 

• start the PC software and choose the COM port the FluoroProbe is connected to (tools -> connect com port -
> search device). 

• calibrate the offsets and/or the fingerprint of yellow substances especially in case of low concentrations of 
chlorophyll (<10µg/l) (calibration menu). 

• set the air pressure by using this item in tools -> device -> air pressure 

• start the measurement (Start button in the tool bar). 

• after starting the measurement, it takes about 30s until the first result appears. 

• submerse the FluoroProbe when the first value appears. 

MEASURING PROCEDURE WITH AUTO START PLUG 

• connect the bbe FluoroProbe and the PC with the measuring cable / RS485 to USB converter-cable, making 
sure that the connector has been greased sufficiently and the internal battery is charged. 

• start the PC software and choose the COM port the FluoroProbe is connected to (tools -> connect com port -
> search device). 

• calibrate the offsets and/or the fingerprint of yellow substances especially in case of low concentrations of 
chlorophyll (<10µg/l). See chapter calibration for details. 

• choose the menu item “Parameter  -> online” 

• set “Measurement on power-up” to “on” on the Common Parameters page, set the desired measuring time / 
interval.  

• for long-term measurements, choose also “Power down after measurement” to save energy.  

• click on “OK” to sync this setting with the FluoroProbe 

• disconnect the measuring cable 

• to start the measurement, connect the autostart plug, the measurement starts immediately after connection. 

• to stop the measurement, disconnect the autostart  plug. 

• to obtain the data from the FluoroProbe, connect the USB cable with the USB stick attached to the 
FluoroProbe, all previously unsaved data files will be copied to the USB stick and can then be transferred to 
bbe++. 

DATA STORAGE 

The measuring results are stored in files in the FluoroProbe. Starting the measurement starts a new file. The 
maximum file size is 1,754 datasets. If this number is exceeded, the FluoroProbe automatically opens a new 
file. 
Once the data files are downloaded via USB, they are deleted from the FluoroProbe. 

OFFSETS 

The following are possibilities to deal with the offset: 
 

1. The offsets are most important if the concentration of chlorophyll is low, for example lower than 10µg/l. 

In these cases, the fingerprint of the yellow substances should be recalibrated by using ultra-filtrated 

sample water (see below). 
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2. In case of stable concentrations of yellow substances, the results of the chlorophyll measurement may 

become more stable if the yellow substances are deactivated. In this case, the offset “ultra-filtrated 

water” is used for the calculation. Please calibrate this offset before choosing this option. 
 

 
 

Calibration procedures 

CALIBRATION OF THE OFFSETS: 

• for the calibration of the offsets, please use ultra-filtrated sample water and distilled water. 

• be sure that the FluoroProbe and its windows are clean. 

• avoid artificial light during the calibration, especially fluorescent lamps! 

• a calibration cylinder from bbe is recommended. 

• be sure that the calibration cylinder is clean as even small amounts of algae might disturb the calibration 
considerably. bbe recommends the use of a dedicated container/canister to calibrate the offsets. 

• remove air bubbles by moving the FluoroProbe around 

• submerse the FluoroProbe in the distilled sample water and use “Device -> FluoroProbe -> Calibration -> 
Offsets (distilled). 

• apply the values after the calibration. 

• submerse the FluoroProbe in the ultra-filtrated sample water and use “Calibration -> Offsets (ultra-filtrated). 

• apply the values after the calibration. 

0
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Offset destilled water Offset ultra-filtrated water

Composition of the offsets

Instrument offset Yellow substaces offset
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CALIBRATION OF THE ALGAE FINGERPRINTS: 

• do an offset calibration first.

• for the calibration of the algae fingerprints, please use pure solutions of the algae division with a known
chlorophyll concentration. The concentration should be in the range of 50-100µg/l.

• avoid artificial light during the calibration, especially fluorescent lamps!

• a calibration cylinder from bbe is recommended.

• submerse the FluoroProbe in the solution.

• choose “Device -> FluoroProbe -> Calibration -> Fingerprints” in the software, choose the algae class and
enter the concentration.

• choose the type of dilution water used for the calibration.

• start the calibration.

• apply the values after the calibration.

• repeat the procedure with all algae classes activated in the FluoroProbe.

CALIBRATION OF THE YELLOW SUBSTANCES: 

• do an offset calibration first (see procedure above).

• for the calibration of the yellow substances, please use ultra-filtrated sample water.

• avoid artificial light during the calibration, especially fluorescent lamps!

• a calibration cylinder from bbe is recommended.

• submerse the FluoroProbe in the filtrated sample water.

• choose “Device -> FluoroProbe -> Calibration -> Fingerprints” in the software, choose yellow substances and
enter 1 r.u. as the concentration and start the calibration.

• apply the values after the calibration.

CALIBRATION OF THE TOTAL CHLOROPHYLL CONCENTRATION: 

The assumption for this type of calibration is that the composition of the algae classes detected by the 
FluoroProbe matches the composition of the reference method used, however the total chlorophyll 
concentration is different. Proceed as follows: 

1. In the Probe

• connect the FluoroProbe to the PC

• choose the menu item “Device -> FluoroProbe -> Edit parameters”

• choose “Parameters of measurement”

• change the global correction factor.

• apply the values.

2. In data files

• choose the access level “Service” as a minimum

• load a data file

• choose “Data -> Parameters -> Recalc data with changed parameter”

• change the global correction factor by following the “Recalc data with changed parameters” procedure.

CALIBRATION BY FACTORS: 

The assumption for this type of calibration is that there is a number of results of the bbe FluoroProbe and of a 
reference method that show a certain factor for one algae class. It is highly recommended to use only 
measurements where this algae class is dominant and the concentration is at least 10µg/l. 

• choose “Device -> FluoroProbe -> Calibrations -> Correction factors” in the software

• choose the algae class and enter the determined factor.

• apply the values.
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CALIBRATION OF FINGERPRINTS WITH SUBSEQUENT WET-CHEMICAL ANALYSIS: 

In case of calibrating the bbe FluoroProbe with a reference solution where the concentration is determined 
subsequently, the following steps have to be carried out: 
 

• do a fingerprint calibration as described above, but enter 1 for the concentration of the reference solution. 

• do a wet-chemical analysis. 

• use the “Calibration by factor” feature to adapt the calibration to the result of the subsequent wet-chemical 
analysis. 

 
Attention: until the last step has been carried out, the bbe FluoroProbe is not ready for use. 

Recalculation of data with changed algae classes or parameter settings 

The bbe++ software provides the possibility to recalculate the data with parameter settings different from those 
that were active during the measurement. 
 
Possible applications are: 
 

• refitting the algae classes with different/new classes 

• recalculating the depth measurement 
 
To do this, follow the instruction for recalculation: 
 

• create a copy of the current parameters 

• change the corresponding parameter, for example the algae classes used for the fit. 

• click “OK” to start a recalculation 

• use the “Restore data with original parameters” feature to return to the old values. 
 
Please note: The recalculation is valid for the selected data sets only. 

Storing the FluoroProbe 

The best way to store the FluoroProbe is in the original box from bbe (utility case). Please store the 
FluoroProbe in a dry state using the protection cap. 
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Operating Principles 

Principles of Operation 

 
Due to the fact that algae of the same division contain a similar quantity and quality of photosynthetic pigments, 
their fluorescence excitation spectrum (with a fixed emission wavelength at 680nm) is significant. Thus, it is 
possible to differentiate divisions of algae by their fluorescence excitation spectrum. In addition to this, other 
fluorescing matter (for example, yellow substances) is detected to enhance the accuracy.  

The bbe fluorometers use 6 LEDs for fluorescence excitation for algae differentiation. The LEDs emit light at 6 
selected wavelengths (370nm, 470nm, 525nm, 570nm, 590nm and 610nm).  

DETERMINATION OF DIFFERENT ALGAE 

 
The division of chlorophyceae (green algae) shows a broad maximum of fluorescence at the 470nm LED, which 
is caused by chlorophyll-a and -b. The cyanophyceae (blue-green algae) have their maximum at 610nm due to 
the photosynthetic antenna pigment phycocyanin. Cyanophyceae also contain chlorophyll-a if there is low 
intensity at 470nm. This is due to the masking effect of the phycocyanin. Furthermore, the high peak at the 
525nm region for the bacillariophyceae originates from xanthophyll fucoxanthin and for the dinophyceae from 
peridin. The maxima at 470nm are caused by chlorophyll-a and -c. In our last analysed group, cryptophyceae, a 
significant maximum can be found at 570nm, which originates from phycoerythrin. 
 
The different divisions of algae are first measured separately to calibrate the instrument. The measured spectra, 
or fingerprints, are then stored in the FluoroProbe.  
During the measurement, the spectrum of the sample is loaded into the storage device of the instrument or sent 
to an external computer. The computer calculates the content of the different divisions of algae in the sample 
from the sample spectrum and the spectra of the separately measured algae divisions. 
 
The concentration of every algae division is given in µg chlorophyll-a/l. 

DETERMINATION OF YELLOW SUBSTANCES 

Yellow substances may fluoresce. 
The UV LED (370nm) is used to measure yellow substances in the water. At 370nm it is possible to differentiate 
between algae (low signal) and yellow substances (high signal). The result of this measurement is given in 
relative units and not in weight/volume, because very different substances are detected. The result is mainly 
used to obtain a more accurate determination of algae classes – but it is also possible to determine the 
variations of the yellow substances. 

DATA ANALYSIS 

Offset 

The LEDs in the bbe fluorometer are switched on one after the other at high frequency. The fluorescence signal 
for each LED is taken and averaged during a given measuring time. The fluorescence values for each of the 
LEDs are given at the end. The concentration of the algae has to be calculated from these values. 
 
The first step is to subtract the signal that does not come from the algae. This type of signal is also called offset. 
There are two types of offsets: 
 

1. the signal from the bbe fluorometer itself, from the electronics and the optical system 
2. the signal from fluorescent substances in the water that are not algae. 

 
The first signal is determined by a measurement with distilled water – water without any fluorescent substance. 
The second signal can be determined by a measurement in ultra-filtrated sample water. This water only 
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contains fluorescent substances that are not algae. Ultra-filtration is here understood as filtration with a ‘mesh 
size’ of 0.2 µm. 
 
In the case of a varying concentration of these substances in the water, the subtraction fails. This is why the 
determination of yellow substances has been integrated into the bbe fluorometer. Yellow substances are treated 
as one algae class. Varying concentrations can be detected – assuming the fingerprint of the calibrated yellow 
substances matches the yellow substances in the sample. 
 
The first signal only depends on the instrument and only varies within a relatively small range. So there is no 
need to calibrate these settings. The second signal depends on the sample, so there may be a need to calibrate 
this. 

Algae classes 

After subtracting the offset from the measured fluorescence signals, the remaining signals have to be assigned 
to the different algae classes. A statistical calculation procedure in the software finds the best combination of 
concentrations of algae classes for the measured pattern of signals. 
 
The total chlorophyll concentration is the sum of all detected concentrations of algae classes. 
 
The signal can only be assigned to algae classes that are calibrated and activated in the instrument. Algae 
classes in the sample that are not part of the calibration will lead to miscalculations.  
 
The different algae classes used for the statistical fit need to have significantly different fluorescence spectra 
such as the spectra calibrated by bbe in the bbe fluorometer. In case of queries, please ask bbe Service. 
 

Additionally Measured Parameters and their Calculations 

PRESSURE 

The pressure is measured with an integrated sensor. The depth of the FluoroProbe is calculated from the 
pressure. 

CALCULATION OF THE PRESSURE FROM THE SENSOR SIGNAL 

 
pressure [bar] = slope [bar/digit]* (signal [digit] – offset [digit])  

CALCULATION OF THE DEPTH FROM THE PRESSURE 

 
depth [m] = (pressure [bar] - air-pressure [bar]) * 10 [m/bar] 
 

WATER TEMPERATURE (OPTION) 

The water temperature is measured with a sensor either next to the transmission window of the probe or on the 
back side of the FluoroProbe.. 

CALCULATION OF THE WATER TEMPERATURE FROM THE SENSOR SIGNAL: 

 
water temperature [°C] = slope [°C/ digit]* (signal [digit] – offset [digit])  

TRANSMISSION 

The transmission of the water is measured with a 700nm LED opposite the detector. It is measured in per cent, 
where 100% is pure water and complete “black water” is 0%. The transmission can be used to compensate 
errors in the chlorophyll measurement that are caused by particles in the water which absorb either the 
excitation light or the fluorescence light. This compensation can be switched on and off. 
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CALCULATION OF THE TRANSMISSION FROM THE SENSOR SIGNAL 

transmission [%] = slope [%/digit]* (signal [digit] – offset [digit])  

COMPENSATION  OF THE CHLOROPHYLL CONCENTRATION BY THE TRANSMISSION 

First step of the compensation is to estimate the turbidity from the transmission readings: 

Turbidity = a * transmission
2
 – b * transmission + c

The estimation is based on measurements using clay as a model for turbidity. The coefficients a, b and c are the 
same for all FluoroProbes. 

The turbidity is used to compensate two effects: 

1. The higher offset due to additional reflexion on the particles
2. The change of the signal (raw value) due to the mitigation of the light.

The offset is compensated by adding the turbidity multiplied with a factor that depends on the FluoroProbe and 
a factor which is independent from the FluoroProbe. The factor which depends on the FluoroProbe is calculated 
from the fingerprints. The correction is done separately for each LED. 

Offset cor.  = Offset + Turbidity * FactorFluoroProbe(LED) * FactorReflexion(LED) +  

Raw value cor. = Raw val. * (1 + Turbidity * Factor mitigation (LED)) 

After doing the correction, the calculation of the chlorophyll concentrations is done as normal. 

TEMPERATURE 

There is a very low drift of temperature in the FluoroProbe. It can be compensated by a measurement of the 
internal temperatures. For this, the input of temperature correction factors is possible. A correction factor is 
defined for each temperature range. The compensation takes place, if the factor is different from 1. The 
temperature is measured by an internal sensor – not by the water temperature sensor. 

COMPENSATION  OF THE CHLOROPHYLL CONCENTRATION BY THE TEMPERATURE 

real chlorophyll conc.[µg/l] = detected chlorophyll conc. [µg/l] * correction factor (temp) 

BRIGHTNESS OF THE LEDS 

The fluorescence signal depends directly on the brightness of the excitation light (LED). The brightness is 
measured internally. At the beginning of the measurement the LEDs are regulated to a default value. During the 
measurement, a frequent control measurement takes place. 
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FluoroProbe Workstation 25 (Options) 

General Considerations 

To use the FluoroProbe in the lab, a desktop/benchtop workstation adapter for the FluoroProbe is available. 
Instead of submersing the FluoroProbe, a cuvette is used to measure the sample. 
The Workstation 25 adapter is available in three versions 
 

1. standard version 
2. with integrated stirrer for FluoroProbe up to series 17 
3. with integrated stirrer for FluoroProbe series 18 and above 

 
Types 2 and 3 are using different voltages.  
 
Please note: 
 
Do not use a Workstation 25 for an unsuitable FluoroProbe. 
 

 
 

FluoroProbe on a Workstation 25 with integrated stirrer 
 

Workstation 25 Standard Version 

PARTS LIST 

• FluoroProbe workstation 

• light shield 

• cuvette 
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SET-UP 

• dismount the light shield from the FluoroProbe by unscrewing the 8 screws. 

• put the FluoroProbe on the workstation as shown above 

• connect the cable to the FluoroProbe and to the power supply delivered with the FluoroProbe 

• connect the converter cable delivered with the FluoroProbe to the power supply as shown on page 17 

• connect the converter cable to the PC 

• start the PC and the bbe++ software 

• measurement of low concentrations might need a recalibration of both offsets (see also page 102) and the 
fingerprint for yellow substances (see also page 103) 

PARAMETER SETTINGS 

To perform measurements with the Workstation 25 kit, the common parameters can be changed slightly. The 
screenshot below shows the recommended settings: 
 
'Measurement interval' 's' 0 

'Measurement time' '1/10s' 200 

'FluoroProbe power-down 
flag' 

 Off 

'FluoroProbe measurement 
count' 

 1 

Warm-up: 

The warm-up time is used to adapt the algae to the light conditions. The brighter the light during the storage, the 
longer the warm-up time. 

Measuring duration 

When compared to the use of the FluoroProbe as a diving probe, the measurement duration is extended to 
enhance the sensitivity.  

Number 

Number is set to 1 to conduct one measurement and stop afterwards. 

Parameter sets 

The bbe FluoroProbe comes with an additional parameter set on a CD, if it is delivered together with a 
workstation. This parameter in a *.FLP file set can be import into bbe++. After that a parameter template can be 
generated. This makes it easy to switch between two parameter sets. 

PERFORMING MEASUREMENTS 

• remove the light shield 

• fill the sample in the cuvette and put it in the mount 

• replace the light shield 

• start the measurement by clicking “Device -> FluoroProbe -> Start measurement” 

Workstation 25 Stirrer Version 

PARTS LIST 

• FluoroProbe workstation 

• light shield 

• control unit 

• stirrer cable 

• cuvette 

• magnetic stirrer 
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SET-UP 

• dismount the light shield from the FluoroProbe by unscrewing the 8 screws.

• put the FluoroProbe on the workstation as shown below

• connect the cable to the FluoroProbe and to the control unit

• connect the converter cable delivered with the FluoroProbe to the control unit.

• connect the converter cable to the PC

• connect the stirrer to the control unit

• connect the control unit to the mains and switch it on

• start the PC and the FluoroProbe software

• put a cuvette with water and the magnetic stirrer on the workstation and adjust the stirring speed as desired

• measurement of low concentrations might need a recalibration of both offsets (see also page 102) and the
fingerprint for yellow substances (see also page 103).
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PARAMETER SETTINGS 

Use the parameter settings as shown above (page 109). 

PERFORMING MEASUREMENTS 

• remove the light shield 

• fill the sample into the cuvette with the magnetic stirrer disk and put it on the workstation 

• adjust stirring speed if necessary 

• replace the light shield 

• start the measurement by clicking “Device -> FluoroProbe -> Start measurement” 
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FluoroProbe Flow-Through Unit (Option) 

General Considerations 

The Flow-Through Unit is designed to provide the FluoroProbe with a defined flow of water. Especially if there 
are a couple of instruments which analyse the same water. 

The Flow-Through Unit can be used underwater or in a monitoring station. Please note that it is not equipped 
with a cleaning device, so that the FluoroProbe has to be cleaned regularly. 

The Flow-Through Unit has to be mounted horizontally to make sure, that no air remains inside. 

bbe FluoroProbe with Flow-Through Unit 
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Flow-Through Unit 

PARTS LIST 

• a three-section Flow-Through Unit with 2 hose connections

• 2 sealing rings

• 2 threaded rods with nuts and washers

SET-UP 

MAINTENANCE 

It is strongly recommended to clean the windows of the FluoroProbe regularly. The cleaning interval depends on 
the concentration of algae and particles in the water as well as on the temperature. 
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Troubleshooting 

Please call us: 

Tel.: +49  431 380 40-40 (Service) 
Tel.: +49  431 380 40-0  

Fax: +49  431 380 40-10 

Or send an email to: 

e-mail: bbe@bbe-moldaenke.de
www.bbe-moldaenke.de

We will gladly help you. 

Instrument Does Not Start 

• check the power-up procedure (see page 11), do the LEDs indicate sufficient power supply?

• rechargeable battery is empty

• power supplier is not connected

• charger and power supply mismatched.

• FluoroProbe has been used via modem. The FluoroProbe attempts to find a modem for about
1 minute. Please wait for a connection.

PC Does Not Recognise the FluoroProbe 

• wrong COM port is being used

• one cable is disconnected

• COM port is used by other software (mouse pad/IR interface), please refer the manual of the PC

• a virus scanner is used that delays the data; deactivate the virus scanner and try again.

• the RS232 port – especially of some low-power laptops - does not provide enough power for the RS232 to
RS485 converter, try again with a desktop PC or a USB to RS232 converter.

• Update the driver for the USB to RS485 converter (http://www.ftdichip.com/Drivers/D2XX.htm).

Problems in Detecting Low Concentrations 

• please use the screen

• recalibrate the offsets in ultra-filtrated sample water

• recalibrate the yellow substance fingerprint

Problems in Detecting Algae Classes 

• recalibrate the offsets in ultra-filtrated sample water

• try to measure with deactivated yellow substances, in case of constant concentration of yellow substances.

• you may have another type of algae in the water. In this case, you have to calibrate a new algae class and
use this one instead of the one calibrated by bbe

• did you calibrate an algae fingerprint and use the wrong dilution water?

• if you are certain that one type of algae is not in the water, please disable this type of algae

Nijverheidsstraat 9, 
6987 EN Giesbeek, The Netherlands
T +31 313 880 200
E info@eijkelkamp.com
I royaleijkelkamp.com
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Data and Tables 

Technical Data 

Weight 7.2 kg 
Size (H x ∅) 450 x 140 mm 

Maximum depth 100 m 
Maximum depth (FP1000) 1000 m 

Temperature range (working) -2 – 35 °C
Temperature range (storage) 0 – 50 °C

Measuring range 0-200 µg chl-a/l
Data capacity 512 MB


